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CCH® ProSystem fx® Knowledge Coach
Welcome to 2017 Knowledge-Based AuditsTM of Dealerships for Knowledge Coach
This Release Notes document provides important information about the 2017 release of Knowledge Based AuditsTM of Dealerships. Please
review this information carefully. If you have any questions, additional information is available on CCH Support Online.

New in this Release
Knowledge-Based Audits of Dealerships
This title is designed to provide practitioners with an effective approach for conducting high quality audit engagements of dealership

entities using the KBA methodology. The Knowledge-BasedTM Audit (KBA) methodology is designed to help the auditor efficiently and
effectively perform financial statement audits of nonpublic dealership entities and has been developed to be compliant with
auditing standards generally accepted in the United States of America (U.S. GAAS). This publication is applicable for all types of
dealership entities, including vehicle and equipment dealers.
The operations of dealerships are generally unique and complex and require specialized accounting and auditing knowledge. Dealerships
face some unique accounting and reporting challenges (e.g., inventory; financing income; insurance income; commissions; warranties, and
repossession losses) that auditors should be aware of when planning and performing the audit engagement.

This specialized dealership approach contains documents and audit programs that have been developed to help the practitioner
apply an audit approach. Entities may have other material transactions that will require additional procedures not anticipated by the
KBA methodology. The practitioner needs to design appropriate procedures and incorporate them into the engagement plan.
Conducting audits of dealerships requires the exercise of the practitioner’s professional judgment. This document is published for the
purpose of communicating the updates and enhancements included in the current version to users of the toolset. This document is not,
and should not be used as an audit program to update the audit documentation of an engagement started in a previous version of this
product.
This is the second update to the Audit portion of this Knowledge Coach title. If you are updating from a previous version of the Audit title,
refer to the Knowledge Coach User Guide Chapter 12. The guide is found on the Engagement File Room Help menu.
The 2017 documents include Accounting Research Material links to specific guidance that provides instant access to detailed analysis
related to the steps and processes discussed in the workpapers.
Note: Preparation, Compilation, and Review material is also available for Dealerships as a separate Knowledge-Based title. Please ask your
sales representative for more information on this title.
2017 Edition of Knowledge-Based Audits of Dealerships
This edition features numerous enhancements, including:
•

Adding a tailoring question in AUD-100 in response to SAS No. 130, which asks if the auditor will be performing an integrated audit.
This tailoring question will show/hide procedures in AUD-101, AUD-701, AUD-901, KBA-201, KBA-412, KBA-904, AID-601, and AID903 based on the user's answers.

•

AUD-903 and AUD-904 streamlining and minimization for duplication elsewhere. Some steps in AUD-903 have been moved to KBA501.

•

Splitting AUD-802 Audit Program: Securities, Derivatives, and Hedging into AUD-802A Audit Program: Investments in Securities and
AUD-802B Audit Program: Derivative Instruments and Hedging Activities.

•

Splitting the Investment in Securities, Derivative Instruments, and Hedging Activities audit area from the 2016 Dealerships Audit
Title into two separate audit areas: 1) Investments in Securities and 2) Derivative Instruments and Hedging Activities.

•

Adding a new table to KBA-101 for users to document why the auditor isn't testing the operating effectiveness of internal controls.
In AUD-100, if the auditor has indicated the intention to test the operating effectiveness of internal controls over financial
reporting, this table will be hidden.

•

Reorganizing KBA-105 so the user will add entries to column 1 instead of column 3 to make the flow more logical.

•

Adding new columns to AID-701 which will allow the user to select whether the assertion is relevant or not. For any assertion
marked as not relevant, the user will NOT need to complete the planned level of control risk. The selections made in this new
column will flow to other areas of the workpaper.

•

Adding a comments column to KBA-400 Scoping and Mapping Table and in KBA-502 Assertion Level Risk Table.

•

Adding an option for a Not Applicable answer to question 9 of AUD-602.

•

Adding a new Not Applicable option in KBA-103 column 15, "If Not a Material Weakness, Is It Important Enough to Merit Attention
by Those Charged with Gov.?"

•

Adding a new KCO-003 Answer Effects for the Engagement-Level Tailoring Questions Workpaper that will show all answer effects of
each tailoring question in AUD-100.

•

Adding many new AIDs, CORs, RPTs, and RESs as follows:
o

AID-802B Inventory Observation Checklist: Vehicles and Equipment

o

AID-810A Accounts Receivable Analytical Procedures: Service Parts and Body Shop

o

COR-201A Audit Engagement Letter: Integrated Audit

o

COR-901A Management Representation letter: ICFR

o

COR-904A Communication to Entity with Significant Deficiencies and/or Material Weaknesses: ICFR

o

RPT-0901A Unmodified Opinion: Single-Year Financial Statements - Combined Report Expressing an Unmodified Opinion
on ICFR

o

RPT-0901B Unmodified Opinion: Single-Year Financial Statements with Reference Made to Separate Report on ICFR

o

RPT-0902A Unmodified Opinion: Comparative Years Financial Statements - Combined Report Expressing an Unmodified
Opinion on ICFR

o

RPT-0902B Unmodified Opinion: Comparative Financial Statements with Reference Made to Separate Report on ICFR

o

RPT-0919A Unmodified Opinion on Internal Control over Financial Reporting When Making Reference to the Report of a
Component Auditor

o

RPT-0960 Unmodified Opinion: Separate Report on ICFR

o

RPT-1004 Adverse Opinion: Separate Report on ICFR

o

RPT-1019 Disclaimer of Opinion: Separate Report on ICFR
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o

RPT-1033 Unmodified Opinion: U.S.-Form Report on an Audit Conducted in Accordance with Both U.S. GAAS and the
Standards of the PCAOB When the Audit Is Not Within the Jurisdiction of the PCAOB

o

RES-025 Special Considerations in Auditing Financial Instruments

o

RES-026 Illustrative Management’s Report on Internal Control over Financial Reporting

o

RES-027 Considerations of an Audit of Internal Control over Financial Reporting That Is Integrated with the KnowledgeBased Audit of Financial Statements

Click here for the 2017 Audits of Dealerships Title Overview for Knowledge Coach Users
In addition, forms and practice aids throughout have been updated to include new examples and tips and, where applicable, to take into
account:
New literature, standards, and developments, reflected in the following current audit and accounting guidance:
•
•
•
•

SAS-131, Amendment to Statement on Auditing Standards No. 122 Section 700, "Forming an Opinion and Reporting on Financial
Statements" (AU-C Section 700)
SAS-130, An Audit of Internal Control Over Financial Reporting That Is Integrated With an Audit of Financial Statements (AU-C
Section 940)
Revised AICPA Code of Professional Conduct (Code) including ET Section 1.295, Nonattest Services
FASB Accounting Standards Codification™ as of March 31, 2017, through Accounting Standards Update No. 2017-07

Important Notes:
•

Make sure to save changes to workpapers before closing the workpaper or the binder to ensure data is correctly updated.

•

If your Current Editor Knowledge Coach MS® Word workpapers become read-only or crash, please do the following:

•

o

Keep the binder with the affected workpapers open.

o

Highlight the workpaper in the binder window and go to Tools > Save Knowledge Coach Answers.

As of the December 2016 update to Engagement 7.5 and Knowledge Coach 2.5, you can open binders that contain Knowledge
Coach workpapers when logged into the Shared File Room (SFR) mode in Engagement with the following restrictions:
o

Knowledge Coach workpapers cannot be edited in the SFR mode.

o

However, Knowledge Coach workpapers can be viewed as read-only, signed off on, and workpaper notes can be written on
Knowledge Coach workpapers while in the SFR mode.

o

Non-Knowledge Coach workpapers can be edited in SFR mode without restriction.

System Requirements
•

These titles MUST be used with CCH® ProSystem fx ® Engagement v7.5 or higher, Knowledge Coach v2.5, and 2016 Financial
Statement Base v4 or higher. If you have not installed the Engagement v7.5 and Knowledge v2.5, ensure that you do so before using
this title. If you are upgrading from Engagement v7.1 or lower please contact Technical Support.

•

A minimum of 4GB of RAM is required for optimal performance when opening and navigating through Knowledge Coach
workpapers.

Download Instructions
Download the 2017 Knowledge Based Audits of Dealerships from the Knowledge Coach Updates section of the Engagement Support
Website. Then select the Knowledge Coach Series and Download file link next to the 2017 Knowledge-Based Audits of Dealerships. On some
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occasions the content package file (.KCP) will download with the extension changed to .ZIP. If this occurs, please change the extension of
the downloaded file to KCP using all capital letters.
You must install the 2016 Financial Statement Base v4 title before installing the 2017 Knowledge Based Audits of Dealerships.
The Financial Statement Base title is also available on the Knowledge Coach Update Website.
Important: Engagement v7.5 or higher and Knowledge Coach v2.5 must be installed on the computer in order to install this Knowledge
Coach title. For additional requirements, please review the System Requirements on our CCH Support website.
The Knowledge Coach Content Package (KCP) download is a proprietary file that must be installed from within Engagement. Save this KCP
file to a location on your local drive, and follow the Installation Instructions included in the Release Bulletin.

Installation Instructions
Once you have downloaded your Knowledge Coach title, you will need to add it to the list of titles within CCH ProSystem fx Engagement.
The only additional system requirement is approximately 75MB of disk space to store your Knowledge Coach Program content files. Please
refer to the Engagement with Knowledge Coach Release Notes for any other system requirements.
After downloading the 2017 Knowledge Based Audits of Dealerships, do the following:

1.

Launch the Engagement Workpaper Management application so that the Local File Room is displayed. Select Tools > Knowledge
Coach Titles.

2.

The Knowledge Coach Titles window will be displayed.

3.

Choose Add Title.

4.

Browse to the title package file (*.KCP) that you previously downloaded from the Knowledge Coach Support Web site.

5.

Choose Open.

6.

The system will display a progress indicator while the title package is added. You will receive a message that the title has been
successfully installed once the process is complete.

To release a title:

1.

Select one of the Knowledge Coach titles in the list that has been added but is not yet released.

2.

Choose Release Title. The current date and time will be displayed in the Date released column, and the status will change to
“Released.”

Note: In the Engagement Admin module, add and assign a Knowledge Coach module and the applicable Knowledge Coach title license to
staff before using the workpapers.
Important: Once the 2017 Knowledge-Based Audits of the Dealerships title has been added and released, they will be automatically
deployed to other staff members when they login to the “Office” location, or when they synchronize a binder that contains Knowledge
Coach workpapers from this title.

Online Permission Key
Permission key files may be downloaded from our website or when adding or updating the new licenses within CCH ProSystem fx
Engagement with Knowledge Coach v7.5 and higher. After updating the license file in the Engagement Admin module, licenses need to be
assigned to the staff who will use 2017 Knowledge-Based Audits of Dealerships.
4

If you have not already established a Single Sign-on (SSO) account with Customer Service, we urge you to do so at this time.

CCH® Accounting Research Manager®
CCH’s Accounting Research Manager ("ARM") is the most comprehensive, up-to-date and objective online database of financial reporting
literature. It includes all authoritative and proposed accounting, auditing, and SEC literature, plus independent, expert-written interpretive
guidance.
Available this Summer on ARM, the Knowledge-Based Audits of Dealerships Guide helps you comply with the most recent professional
standards and guidance for the conduct of audits of Dealerships and to integrate the use of practice aids, tools, and other resources with its
guidance. This publication supplements and complements the Knowledge-Based documents that are available in Knowledge Coach.
With Accounting Research Manager, you maximize the efficiency of your research time, while enhancing your results. Learn more about our
content, our experts, and how you can request your free trial by visiting the Accounting Research Manager website. You can also access the
Accounting Research Manager Web site by selecting Engagement > Binder Window > Shortcuts Bar > Guidance tab.

Using Your Knowledge Coach Content
To use your Knowledge Coach Workpaper Templates, do the following:

1.

Open a binder in Engagement.

2.

Select the workpaper tab into which you would like to insert the workpaper.

3.

Select New Knowledge Coach Workpaper from the toolbar or File menu.

4.

The New Knowledge Coach Workpaper dialog appears (Figure 1).

5.

Select the New Knowledge Coach Title with the content you would like to use. You can only select titles you have installed. The
information displayed changes to reflect the workpaper organization available for the selected title.

6.

Select the Knowledge Coach Workpapers to insert into your binder and click OK.

7.

In the Selected Workpaper Properties dialog, each workpaper name is automatically loaded into the Name field. Add a workpaper
index in the Index field and make any Name modifications you desire. You can also modify the tab location or the roll forward
settings for each workpaper.

8.

Click OK. The integrated Knowledge Coach workpaper is now inserted into your engagement binder.

Note: For more information on how to use Knowledge Coach workpapers in your binder, see the Knowledge Coach User Guide.
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Figure 1 - New Knowledge Coach Workpaper

Additional Information on Knowledge Coach and the KBA Methodology
Knowledge-Based Audit (KBA) Methodology
Allows the results of one set of procedures to become the input for the next. The key components of the KBA methodology include:
•

An Overview that guides auditors through the methodology;

•

Knowledge-Based Audit documents, integral to the risk assessment and overall audit processes, which contain steps and
procedures required by U.S. GAAS;

•

Customizable Audit Programs that take auditors through related steps and procedures;

•

Practice Aids to help auditors complete steps or processes outlined in the Knowledge-Based Audit documents and Audit Programs;

•

Auditor’s Reports that provide a variety of sample auditor’s opinions on audited financial statements; and

•

Correspondence documents that provide sample letters to be used to comply with U.S. GAAS requirements and in many other
common situations.

•

The AICPA’s Auditing Standards Board’s (ASB) Risk Assessment Standards - The practice aids and tools in the 2017 KnowledgeBased Audits of Dealerships are designed around the AICPA’s risk assessment and clarified standards to assist auditors of
dealerships by:
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–

Facilitating compliance with GAAS;

–

Encouraging more effective audits through tailored audit programs and comprehensive practice aids;

–

Helping auditors to focus on and respond to identified audit risks; and

–

Enhancing audit documentation.

CCH® ProSystem fx® Knowledge Coach
Knowledge Coach functionality allows auditors to use the Knowledge-Based-Audit methodology more efficiently by eliminating the need for
duplicate entry of the same information, tailoring audit documentation to each particular engagement, and documenting the link between
risks identified and procedures performed. AUD-100 Tailoring Question is a document in Knowledge Coach that presents engagement-level
questions designed to aid in tailoring the engagement documentation to fit each client. Completing the questions helps the auditor avoid
duplication and unnecessary workpapers.
Note: Before you begin your audit, please review the guidance in AUD-101 Overall Audit Program. This workpaper is intended to be your
road map through a Knowledge-Based Audit methodology. You should start your audit with AUD-100 Tailoring Question Workpaper and
AUD-101 Overall Audit Program.
•

Risks
Can be captured via the Risk Summary task pane from any Knowledge Coach workpaper by the current editor of KBA-502
Summary of Risk Assessments. This allows the user to continuously assess risks during the engagement. Several workpapers
prompt the consideration of the presence of risks, but the Risk Summary task pane must be used to document those risks. All
documented risks flow to the Risk Summary. To ensure risks show in findings tables, make sure to check the “workpaper identified
in” field of the Risk pane.

•

Information Flow
Helps cut down on the time spent duplicating information across forms. In addition, the flow of consistent information ensures
that information and updates to information are not missed between workpapers. Drill-down functionality helps the user navigate
quickly to the source of the information, aiding in the review of the audit file.

•

Diagnostics
Help keep track of unresolved issues like unanswered questions, incomplete risks, program steps not linked to risks or relevant
assertions, missing workpaper, and more.

•

Links to Accounting Research Manager (ARM)
If you subscribe to an ARM library that includes audit content, you can link directly to source material from Resources within
Knowledge Coach workpapers. These links have been updated to reference to the accounting standards under the FASB
Accounting Standards Codifications and the auditing standards issued by the AICPA. Also, if you subscribe to the Knowledge-Based
Audits of Dealerships Guide on ARM, you can take advantage of links to the audit guide material from within the Knowledge Coach
documents.

•

Interpretive Guidance
It is integrated into each Knowledge Coach template through the Tips view of each new task pane. Informational features include
Practice Points, Examples, Optional Workpapers, and Resources to help auditors work more effectively and efficiently. You can
also navigate from Resources within a document or the tip pane directly to CCH’s Accounting Research Manager and industry
audit guides by simply clicking on the Reference.

Download Description:

2017 Knowledge-Based Audits of Dealerships (5/18/2017)

Version:

Engagement v7.5 with Knowledge Coach v2.5 or higher and 2016 Financial Statement Base v4

Release Date:

May 2017
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File size:

18MB

Approx. Download Time:

42 minutes at 56 kbps

License:

Full Version

Platforms:

Windows® 7, 8, 8.1, 10

Office:

Microsoft® Office 2010 or higher required
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